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1 Introduction

3DELIGHT FOR XsI is a fully integrated rendering plug-in for SOFTIMAGE® | xS1®1, 1
is based upon a heavy-duty, production ready and fully featured RenderMan(c)-compliant
renderer: 3DELIGHT.

The primary aim of the product is to provide XsI users with realistic rendering solutions
to some known issues with the internal renderer. This includes, among other things:

e Automatic conversion of XSI shaders into RenderMan(c) shaders.
e Fast 3-D motion blur and depth of field.

e Efficient rendering of “hair” and “fur”.

e Fast and accurate displacements.

e Fast and accurate rendering of smooth surfaces such as subdivision meshes, NURBS
and curves.

e Beautiful anti-aliasing, as suitable for high-end film rendering.
e KEfficient rendering of complex scenes.
e Complete geometry support: polygons, subdivision surfaces, NURBS, curves, particles.

e Advanced RIB export and import features.

The second aim is to introduce some rendering concepts and methodologies found in
RenderMan(c) pipelines into the Xs1 world. More about 3DELIGHT FOR XSI features in
Chapter 3 [Features Summary]|, page 5.

1.1 Further Readings

This document contains everything you need to work with 3DELIGHT FOR XSI. For the
interested, here is a list of additional readings:

3Delight User’s Manual.
A recommended reading for users interested about the internals of 3DELIGHT.

The RenderMan Companion, by Steve Upstill.
Although quite aged, this book is still a very good introduction® to the
RenderMan(c) standard and “spirit”.

Advanced Renderman, by Anthony A. Apodaca and Larry Gritz.
A production oriented RenderMan textbook.

The RenderMan Specifications 3.3
An essential reading for serious RenderMan(c) practitioners and hobbyists.

1 And to our knowledge, the first after xsI's integrated renderer.
2 And in author’s opinion, the best.



Chapter 2: Installation 3

2 Installation

3DELIGHT FOR XSI comes as an XSI add-on and is thus installable as any other add-on. The
only additional step is to start the license manager®. If you have already a 3DELIGHT license
server running, please refer to Section 2.6 [Licensing More Than One Product], page 4.

2.1 Getting a License

Please contact us at sales@3delight.com to get the 3DELIGHT FOR XSI package. The pack-
age is a standard XsI add-on that can be installed by a drag-and-drop of the uncompressed
package onto the XS1 window.

In order to obtain a license, you must send us the hostid of your machine, which you
can obtain by going through the following steps:

1. Install the add-on
2. Open the Plug-in Manager window (File -> Plug-in Manager)

3. Right click on the 3DELIGHT FOR XSI add-on and select Command Prompt. This
will open a command prompt with the current directory being the root of the add-on
installation.

4. In the command prompt, issue the following command: cd Application\bin\nt-x86

5. And then issue: licutils hostid

This will give you a unique hexadecimal identifier of the current machine, you can then
send us this number get your license. Note that you have to run this on your license server

machine.

2.2 Local Install

If you are installing 3DELIGHT FOR XSI on your own machine and you plan to run the
license server on the same machine, then the only thing to do is to install the license file
(‘license.dat’) in add-on’s ‘/License’ directory and start the license server as explained
in Section 2.4 [Starting the License Server|, page 4.

2.3 Network Install

If you plan to install 3SDELIGHT FOR XSI on a network (and you probably have a workgroup)
then:

e Put the license file (‘license.dat’) in add-on’s ‘/License’ directory.

e Fill-in in the ‘settings.txt’ files, as explained in Section 2.5 [The Settings File],
page 4.

e Start the license server if not started yet, as explained in Section 2.4 [Starting the
License Server|, page 4.

! There is no license management in the |Demo version.


mailto:sales@3delight.com
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2.4 Starting the License Server

The license server binary (‘licserver’) is installed in the ‘/Application/bin’ directory of
the add-on. There are two batch files to start the license server:

‘licserver-foreground.bat’
Starts the license server in foreground mode. This is useful to see all the log
messages and we recommend this when starting the license server for the first
time.

‘licserver-background.bat’
Starts the license server in background mode. This starts the license server and
returns control to the user. This can be executed at startup time on the license
serving machine.

The license server can also be started “by hand” if necessary (licserver -h for more

infos) but we recommend using the handy batch files.

2.5 The Settings File

The settings file contains information about the location of the license manager® and is
located in the root of the add-on directory. The standard settings file goes as follow:

# put the name of the license server here (if not your local machine)
/3dfx/licserver 127.0.0.1

# 3DFX can wait for available licenses if all are taken. Put "true"
# here if this is the wanted behavour.

/3dfx/waitforlicense false

The following two lines are recognized:

/3dfx/licserver
Points to the machine that is running the license server. The default value
means that 3DELIGHT FOR XSI will look for the license server on the local
machine (putting localhost in this line is the sames as 127.0.0.1). Machines can
be specified either by their name or by their IP address.

/3dfx/waitforlicense
Toggle this to ‘true’ if you want 3DELIGHT FOR XSI to wait for a license if none
are available. The default action is not to wait and report an error.

2.6 Licensing More Than One Product

If you are running both 3DELIGHT and 3DELIGHT FOR XSI licenses at the same time, it is
important to run only one license server. The license file should then contain two license
keys, one for each product and both the ‘settinx.txt’ file (3DELIGHT FOR XSI) and the
‘renderman.ini’ file (3DELIGHT) should point to the same license server.

2 Although it could be used for additional purposes in the future.
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3 Features Summary

3.1 Integration with XSI

Particular care has been taken to ensure a seamless integration with XsI:

Full Render Region Support
Simply select ‘3Delight’ as the current renderer in XSI’s render options and
launch renderings as usual. 3DELIGHT FOR XSI can render into XSI's render
region and frame buffer. All framebuffer channels are supported (such as depth,
normals and alpha).

Complete Render Tree support
3DELIGHT FOR XSI automatically converts XsI’s render trees into RenderMan(c)
shaders and compiles them on the fly’. All textures are converted (if needed)
into 3DELIGHT’s mip-mapped and tiled TIFF format for efficient rendering and
filtering. Material clusters, vertex colors, implicit and explicit projections are
all supported. The following material slots are recognized:

e Surface

e Displacement
e Bump

e Environment

Additionally, the conversion system has been designed in such a way so that
advanced users can convert their in-house shaders to 3DELIGHT format easily.

NOTE: This means that XsI, in conjunction with 3DELIGHT FOR XSI, can be
used as a RenderMan(c) shaders authoring tool.

XsI Shader Balls rendering
3DELIGHT FOR XSI will render XSI shader balls if the user enables this features
in File -> Preferences.

XsI Properties Sharing
3DELIGHT FOR XSI accesses all the common rendering properties so that its
behaviour is as close as possible to XSI’s internal renderer.

Rich Geometry Support
Here is a complete list of supported geometric primitives:

Polygons  All types of polygons are supported. Additionally, polygonal ge-
ometry with a subdivision step greater than 1 will be rendered as
a smooth subdivision surface. Edges and vertices tagged as “hard”
are rendered properly.

NURBS  All NURB surfaces are supported. Trim curves on surfaces are also
fully supported and rendered to sub-pixel accuracy.

L Compilation is multi-threaded to take full advantage of multi-core machines.
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Particles  All particle types are supported with proper shading. Additionally,
3DELIGHT FOR XSI can take advantage of 3DELIGHT’s lightweight
particles to render extremely large clouds of small particles.

Hair Hair is rendered using 3DELIGHT’s efficient RiNuCurves primitive.
Linear, quadratic and cubic curves are all supported. Special RIB
export options for hair enable memory efficient off-line rendering.

Curves 3DELIGHT FOR XSI can render XsI curves of any shape and degree.

NOTE: 3DELIGHT has no tessellation controls other than the ShadingRate. This
means that, by default, all surfaces (hair, subdivisions, nurbs) are rendered as
smoothly as visually required for the given resolution, and this is the normal
operational mode of 3DELIGHT.

3.2 Core Features of 3Delight

Motion Blur and Depth of Field
Multi-Segment motion blur and realistic camera shutter simulation contribute
to high quality rendered images. Compared to other rendering software, motion
blur in 3DELIGHT FOR XSI is fast. Depth of field is fully supported and simulates
a realistic camera bokeh.

High Quality Anti-Aliasing
Edge anti-aliasing, motion blur and depth of field quality are all controlled
using very simple and predictable options. Contrary to other rendering soft-
ware, increasing pixel samples for higher quality anti-aliasing does not affect
performance significantly?.

Geometric Displacements
Displacements are efficiently rendered to sub-pixel accuracy. xsI’s displacement
shaders as well as RenderMan(c) shaders can be used for displacement.

Subsurface Scattering
Automatic subsurface scattering can be enabled on a per-object basis and de-
livers impressive results, fast. All standard Xs1 materials can be used without
modification to achieve subsurface scattering effects.

3.3 Pipeline

RenderMan(c) Shaders Support [Studio]
It is possible to connect RenderMan(c) shaders to geometry (or groups) and use
them instead of XsI’s materials. Surface, displacement and volume shaders are
supported.

Scene Caching [Studio]
This features enables you to “cache” a scene for efficient re-rendering. Once a
scene is cached, the plug-in doesn’t have to parse it for subsequent renders. This

2 By the principle of dissociation between shading and visibility in 3DELIGHT, as explained in 3DELIGHT
FOR XsI User’s Manual.
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minimizes the time necessary to start the render of complex scenes, especially
those with hair®.

RIB Export [Studio/
XSI scenes can be exported into efficiently constructed RIB files. RIBs can be
monolithic or fragmented into smaller archives for memory efficient rendering.
RIB can be outputted in binary and/or compressed format.

RIB Archive Import [Studio]
Individual objects or groups of objects can be replaced by RIB archives. Delayed
RIB archives? are also supported.

RIB “Boxing” [Studio]
The purpose of RIB boxing is to enable the insertion of RenderMan(c) commands
during scene rendering. This is a common facility in RenderMan(c) oriented work
flow.

3 This features is intended primarily for the lighting stage, where rapid feedback is of prime importance.
4 Mainly used in depth-complex scenes, for faster and memory efficient rendering.
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4 The User Interface

3DELIGHT FOR XSI has only three interface pieces and those are well integrated inside XSI:
the renderer properties, the object properties and the RenderMan(c) shaders properties!.

4.1 Renderer Properties

Renderer properties are general properties that apply to the entire render engine. This UI
piece is accessible through the Render -> Render -> Renderer Options menu?.

4.1.1 Quality

Shading Rate
The shading rate is a fundamental quality control parameter and formally
speaking, it defines the rate (or frequency) at which a surface is shaded. From
The RenderMan Companion, page 214:

. [The Shading Rate] controls the frequency of shading a surface. size
is specified as an area in pixels: if size is 1, a surface is shaded about once
per pixel. Large values of size cause cruder but faster shading. "

In most micro-polygon driven implementations, including 3DELIGHT, the shad-

ing rate actually controls how finely surfaces are tessellated. Since the shading

rate is specified in "area of pixels", micro-polygon renderers simply tessellate
surfaces so that each micro-polygon is of the specified area. And since ev-
ery micro-polygon is an atomic unit of shading®, we automatically obtain the
desired shading rate. There is an important implication to this:
Higher shading rates (such as 20) not only make objects look blurrier (less
frequent shading), but also make surface silhouettes look less smooth. This
is because the shading rate and the tessellation are interconnected in a
micro-polygon based renderer.

Note however that shading rate has absolutely no effect on edge anti-aliasing,
which is controlled through the filtering parameters described next.

In practice, the following shading rate values are common:

0.1 to 1.0  For high quality renders. Even lower shading rates can be used for
extremely detailed shaders or textures. Some shaders are not writ-
ten with anti-aliasing in mind* and can exhibit artifacts (especially
in animation), those also require low shading rates.

1.0 to 2.0 For medium quality renders.

>2.0 Draft renders and shadow map renders.

Table 4.1: Common shading rate ranges.

1 RenderMan(c) shaders properties are only available in 3DELIGHT FOR XSI| Studio.

2 Note that 3DELIGHT has to be selected as the active renderer in the Render -> Render -> Pass Options
in order to be accessible in the renderer options.

3 Contrary to ray-tracers, where the smallest unit of shading is a sub-sample.
4 Shaders generated by 3DELIGHT FOR XSI are properly anti-aliased.
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Oversampling

Filter Type

The oversampling (or supersampling) defines the number of sub-samples (or
sub-pixels) there is in each pixel and in each direction. This means that an
Oversampling of 2 tells the renderer to use 4 (2x2) samples for each pixel.
Oversampling has a direct impact on the following;:

Edge anti-aliasing
The higher the oversampling, the lower the probability of aliasing
on geometric edges and sharp shading variations.

Motion blur quality

Depth of field quality
The higher the oversampling, the smoother the motion blur and
depth of field effect.

Specify what filter to use when combining the pixel samples together. The most
useful filters are: ‘sinc’, ‘mitchell’ and ‘catmull’. ‘box’ filter is commonly
used for shadow map rendering or when oversampling is disabled (Oversampling
set to 1) ‘gaussian’ filter is good when softer results are desired but tends to
be too blurry when Filter Width is higher than 2 or 3.

NOTE: Filter type does not affect rendering time. Filter settings that affect
render time are the oversampling and filter width.

Filter Width

The width of the super sampling filter tells the renderer how many pixels to
consider in the final result (also known as the filter support). It is well known
that film-grade quality anti-aliasing can only be achieved using sharper filters
(such as ‘sinc’, ‘mitchell’ and ‘catmull’) and wide filter supports. Values
of 2 to 4 are common for draft renders and values from 6 to 8 are common in
high-end final renders.

Note that because ‘sinc’ and ‘catmull’ filters have negative lobes, it makes no
sense to use a filter width smaller than 4 for these; to better understand the
problem please refer to The RenderMan Companion, page 176.

Table 4.2 gives general guidelines on the common filter parameter ranges for various
render qualities. Additionally, please refer to Section 5.4 [Efficient Rendering of Hair],
page 20 for the particular case of hair rendering.

Quality Filter Width Oversampling Shading Rate
Low box 1 2 10
Low-Medium gaussian 2 2 4

Medium mitchell 3 3 2
Medium-High mitchell 4-6 4 1

High sinc/mitchell 8 8 0.5

Table 4.2: Filter settings guidelines.

4.1.2 Motion Blur
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Motion Steps

Camera Specifies how many motion blur steps to use for the camera. It makes sense to
increase this value for cameras that are moving rapidly and following a non-
linear path.

Transformation
Specifies how many motion blur steps to use for transformation motion blur.
It makes sense to increase this value for rapidly rotating objects such as a car’s
wheel.

Deformation
Specifies how many motion blur steps to use for deforming objects. Unless an
object has an extreme deformation movement, this value should be set to 1.
Having more deformation steps is more expensive (in terms of memory usage)
than having more transformation steps since this implies geometry duplication
inside the renderer.

Shutter Settings
Shutter
Delay

Shutter Efficiency

4.1.3 Depth Of Field
Enables Turns depth of field on or off.

fStop The f-stop of the camera being used. In photography, f-stops usually define dis-
crete steps (because of click-stopped apertures), each step represents a halving
of the light intensity from the previous stop. In 3DELIGHT an f-stop can be any
scalar, so a more formal naming for this parameter would be f-number.

Focal Length
Gives the focal length of the lens being used.

Focal Distance
Gives the distance at which the surface appear in focus.

Extreme Motion Blur with DOF
When rendering effects with extreme motion blur and depth of field, the su-
persampling as specified in Oversampling (see Section 4.1.1 [Quality], page 8)
might not be enough to produce smooth images. This parameter lets the user
control an alternate sampling algorithm that is well suited for this problematic
case. The value specified here dictates the number of iterations of that specific
algorithm and a value of 1 is generally enough to produce smooth results.

4.1.4 Optimization

Multi- Threading
Specifies the total number of threads to use.
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Tile Size

Grid Size

A tile, or a bucket, is the smallest unit of rendered data that the renderer gives
back to the user. From 3Delight’s Users Manual:

"This option specifies the dimension of a bucket (tile), in pixels. Using
smaller buckets may reduce memory use at the expense of slight perfor-
mance loss. In our experience, this default value (16) is the best compro-
mise for 3DELIGHT."

IMPORTANT: Because of a performance problem of the render region in XSI
versions prior to 6.5, using higher values for tile size will greatly accelerate the
render in the render region. This problem should be fixed in newer versions of
XSI.

Grids represent small sets of micro-polygons that are shaded together in an
SIMD manner. From 3Delight’s Users Manual:

During the rendering process, geometry is split into small grids of microp-
olygons. Shading is performed on one grid at a time. This option specifies
the maximum number of such micropolygons per grid. The default value
ensures that one grid covers approximately one bucket (tile). Since by de-
fault RiShadingRate (the Shading Rate property) is one and buckets are
16 by 16 pixels wide, the default grid size is 16¥16/1 = 256.

Texture Memory

Specifies how many megabytes of memory is dedicated to texture caching. From
3Delight’s User Manual:

"The memory needed to hold the texture for a scene may exceed the
amount of core physical memory available. To render such scenes ef-
ficiently, 3DELIGHT uses a memory caching system to keep the texture
memory footprint below a predefined threshold. This option specifies the
amount of memory dedicated to texture mapping algorithms. Increasing
this parameter may improve texture, shadow and environment map access
performance ...".

Disable Ray Tracing

Disables ray-tracing. By default, ray tracing is disabled.

Run Shader For Shadows

Enables the execution of shaders for ray traced shadows (including ambient
occlusion). There is a significant gain in not running shaders when using ray
traced shadows so this feature is disabled by default. This means that objects
will cast shadows as if they were fully opaque. Note that if there is no shaders
connected to material’s ‘Shadow’ slot, 3DELIGHT FOR XSI will not run shaders
either.

4.1.5 Archives and RIB Export

Archive-Rendering and Exporting

Enable

When turned on, this feature makes 3DELIGHT FOR XSI use RIB archives for
rendering. The implications are the following:
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e For render region rendering, 3DELIGHT FOR XSI will create archives for
individual objects in the path specified in Archives Cache Directory.

e For RIB export, 3DELIGHT FOR XSI will create an ‘archives’ directory at
the same directory level as the main RIB and puts archives in there. The
location of the main RIB file is specified through the standard xs1 Pass ->
Archive -> Filename property.

More about RIB export in Section 5.2 [RIB Export and Import], page 19.

Scene Caching

Freeze Archives
When enabled, this option tells 3DELIGHT FOR XSI to reuse already created
archives, effectively implementing a form of scene caching. Subsequent renders
of the same scene will use the saved RIB archives instead of asking Xs1 for the
actual geometry. This can lead to important time gains for complex scenes or
scenes containing hair. We highly recommend to switch this option on for the
lighting phase of your pipeline.
NOTE: Users can still modify shaders or lights and have correct renders
since those are not cached with the archives. Only when geometry is mod-
ified that this toggle should be switched off.

More about this option and scene caching in Section 5.4 [Efficient Rendering of
Hair], page 20.

Archive Cache Directory
Specifies where to put archives when rendering in the render region.

RIB Output Options

Binary When enabled, all RIB files and archives are written in their binary form. Binary
RIB’s are about 2 times smaller than corresponding ASCII RIBs.

Compressed
When enabled, all RIB files and archives are written in compressed form. Com-
pressed RIBs are about 4 times smaller than their uncompressed counterpart.
Compressed binary files are only slightly better than compressed ASCII files
(compression ratios do not multiply, obviously).

NOTE: Compressed RIBs are ordinary gziped files and can be uncompressed
using gunzip. This also means that 3DELIGHT natively reads gziped RIB
files and archives. It is common to name such compressed RIBs with a
‘.gz’ extension, such as in: ‘scene.rib.gz’.

4.1.6 Search Paths

Shaders Specifies the paths where to look for RenderMan(c) shaders. Note that this path
has absolutely nothing to do with the automatic translation of XSI shaders: it
only applies to shaders that are loaded through the renderman shaders proper-
ties page (see Section 4.3 [The RenderMan Shaders Properties], page 17.

Textures  Specifies the paths where to look for textures. This path is considered when
specifying textures in RenderMan(c) shaders loaded through the renderman
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shaders properties. They do no apply to XSI textures: these are automati-
cally handled by the plug-in.

Archives  Specifies where to look for archives that are specified in the RIB archive property
page (see Section 4.2.5 [RIB Archive Object Property]|, page 17).

4.1.7 Displays

4.1.8 Shadow Maps

Render Shadow Maps
Specifies if shadow map rendering is needed. A good use of this toggle is to set
it to ‘off’ after rendering the shadows once (since when lights do not move,
there is no need to re-generate shadows).

Use Shadow Maps
Disable the use of shadow maps in the render, but still generate them (unless
Render Shadow Maps is off).

4.1.9 Render Tree Conversion

Generate RenderMan(c) shaders
Toggles automatic shader conversion on and off. Of course, it is usually nec-
essary to have this toggle turned ‘on’ in order to render XSI scenes correctly®.
This toggle can be switched ‘off’ if shaders are not modified and they have
been already translated once; this can accelerate rendering since the shader
translation phase is skipped.

NOTE: Normally, 3DELIGHT FOR XSI will detect which shaders have been
modified and translate only those but a glitch in XSI versions prior to
6.5 makes recompilation necessary if the render region is changed (which
normally has no incidence on shaders). The existence of this toggle is in
part related to this problem.

Shaders Destination Directory
Specifies the path of the generated shaders. The naming of the shader
itself is ‘[Material Name] _surface.sl’ for surface shaders and ‘[Material
Name] _displacement.sl’ for displacement shaders.

NOTE: There is no “bump” or “environment” shaders in the RenderMan(c)
specifications. Those are still supported by 3DELIGHT FOR XSI and dealt
with inside the surface shader. The way this is done is clearly visible in
the ‘.1’ files, for the interested.

Textures Destination Directory
3DELIGHT FOR XSI will automatically convert XSI textures into mipmapped
TIFF files suitable for 3DELIGHT. This property specifies where those textures
will be stored. Supported texture formats include: pic, tga, tiff%, psd, iff,
gif, openEXR, radiance, sgi and jpeg.

5 Unlsess you are using only RenderMan(c) shaders as explained in Section 5.6 [Using RenderMan Shaders],
page 21.
5 The high dynamic range LoglLuv encoding is supported, as well as floating point TIFFs.
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4.1.10 Network Cache

NOTE: Network caching is only available in 3SDELIGHT FOR XSI| Studio. This feature, unique
to 3DELIGHT, can substantially improve rendering times, network traffic and server load in
networked environments.

From 3Delight Users Manual:

3DELIGHT offers a special extension for more efficient rendering in networked environ-
ments”: a local file cache for textures and archives to minimize network traffic and file
server load. This proves particularly powerful when using a large quantity of rendering
servers.

The working principle of 3DELIGHT’s network cache is to copy files to a local file system
and reuse them when needed. If either a texture or a RIB archive is cacheable and the
file cache is full, one or more files are removed from the cache to make space for the
new one; a LRU (Least Recently Used) strategy is used to choose which texture(s) or
archive(s) to remove from the cache.

Enable Network Caching
Enables the network cache.

Local Network Cache Directory
The directory, on each rendering machine, where the textures and RIB files will
be cached.

Cache Size
The total cache size in megabytes.

Cache Network Writes
Enables network write caching: instead of writing data over the network in
small bursts, 3DELIGHT will write images locally and then transfer them ef-
ficiently at the end of each render. This feature can have a very significant
impact on large render farms.

4.1.11 Diagnostics

Level Of Detail
Specifies how verbose the statistics will be. The default (‘None’) disables statis-
tics.

Format Chooses how to output statistics: XSI console, text file or HTML file.

Message Suppression - Enable
Enables message suppression. All 3DELIGHT messages have an identified, for
example R2020. If you want to suppress certain messages just type them in this
text field, separated by a comma.

Display Plug-in Performance Statistics
Displays additional timings about the plug-in. This was mainly used during
the development cycle and is not of real interest to users®.

" Not available on Windows platforms.

8 It was used to time the performance of XsI's SDK when getting the Hair and when sending data to the
render region.
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4.2 3Delight Attributes

3DELIGHT attributes are ordinary object properties that are useful in 3DELIGHT but un-
available through the XsI interface. It is important to note that 3DELIGHT FOR XSI uses
the standard XsI properties whenever possible, to not disrupt users habits.

This particular UI piece is accessible through the Render -> Property -> 3Delight ->
Attributes menu.

4.2.1 Quality

Shading Rate Multiplier
Controls the shading rate on a per-object basis. The specified value multiplies
the global shading rate set in Section 4.1.1 [Quality], page 8.

4.2.2 Ray Tracing

Trace Displacements
If enabled, the affected objects will be tessellated and displaced for ray tracing®.
If disabled (the default) the 3DELIGHT render engine will not tessellate surfaces
for ray tracing, instead, it will use analytical intersection methods to keep
memory usage low and will use bump-mapping to simulate the effect of the
displacement (which should be enough in most cases).

NOTE: Ray tracing displacements is a costly feature, both in terms of speed
and memory, it should be used with great care.

Trace Motion Blur
Specifies if motion blur effects are to appear in reflections and refractions. This
doesn’t effect the motion blur for “primary rays”.

4.2.3 Subsurface Scattering

Subsurface Light Scattering
Enables or disables subsurface light scattering simulation.

Subsurface Strength
Relative strength of the sub-surface lighting.

Scattering Parameters - Type
Specifies which method to use when specifying surface properties for subsurface
scattering simulation. This is either ‘Absorption & Scatterin’ or ‘Mean Free
Path & Reflectance’.

Scattering Parameters - Preset
Selects a particular subsurface preset.

Refraction Index
Specifies the index of refraction of the underlying object

9 Still, tessellation is performed “just-in-time” and a geometry caching system keeps memory usage in
check.
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Scale Specifies the scale of the underlying model. A scale of 1.0 means that the
model is specified in millimeters. The larger the scale the smaller is the model
(.1 means centimeters and 10 means a tenth of a millimeters). The scale is
necessary because the absorption, scattering and mean free path are provided
in millimeters'® and the renderer needs to know how to interpret the world
metrics. Making the models smaller (by using a scale bigger than 1.0) will
make them more “translucent”.

Quality - Shading Rate
Specifies how finely the geometry will be tessellated when running the subsur-
face scattering simulation. This is similar to Shading Rate property described
in Section 4.1.1 [Quality], page 8.

4.2.4 Geometry

Output Vertex Properties
Output all vertex properties. This should always be ‘on’ since it is needed for
XSI shader support. One could toggle this off if only RenderMan(c) shaders are
used and no vertex properties are needed. Please refer to Section 5.6 [Using
RenderMan Shaders|, page 21 for an example on how to access vertex properties
in a RenderMan(c) shaders.

Output Reference Geometry
Include reference geometry with the main geometry. This is potentially use-
ful when developing RenderMan(c) shaders as explained in Section 5.6 [Using
RenderMan Shaders], page 21.

Output Cluster Sort Orders
Output the cluster sort orders along with the geometry. This is potentially
useful when developing RenderMan(c) shaders as explained in Section 5.6 [Using
RenderMan Shaders], page 21.

Surfaces

Enable Trimming
Enables NURBS trimming. This is ‘on’ by default.

Curves

Render Curves
The default behaviour in 3DELIGHT FOR XSI is to not render curves. Set this
option to ‘on’ to render XsI curves smoothly. All curve types are supported.

Width at Root
Width at Tip
Specifies curve’s width at the root and tip, respectively.

10" Actually, in 1/mm.
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Particles

Use Lightweight Particles
If ‘on’, 3DELIGHT FOR XSI will use 3DELIGHT’s lightweight particles instead
of the geometry speicifed in XsI (sphere, billboard, etc ...). This is useful to
efficiently render large clouds of very small particles.

4.2.5 RIB Archive

Enable Archive Loading
Enables the loading of the archive specified in RIB Archive Name.

RIB Archive Name
The name of the RIB archive to read.

Archive Loading Type
Specifies if the archive has to be loaded in immediate or delayed mode:

‘Immediate’
The archive is loaded as soon as the renderer reaches the associ-
ated object. This is often useful when the archive contains only
RenderMan(c) attributes and no geometry.

‘Delayed’ The archive is loaded when the renderer encounters the bounding
box of the associated object. This should be the default mode for
archives containing geometry since this can greatly improve render-
ing performance.

Please refer to Section 5.2 [RIB Export and Import], page 19 for more about archive
loading.

4.2.6 RIB Box

RIB boxing is a common technique to pass custom RenderMan(c) commands to the renderer.

Any valid RIB command which is appropriate in the current context, can be used.

4.3 RenderMan Shaders Properties

NOTE: This feature is only available in 3DELIGHT FOR XSI| Studio.

This property is a shader assignment UI to connect RenderMan(c) shaders to objects
or groups of objects. The UI is accessible through the Render -> Property -> 3Delight ->
Shaders menu.

The interface will show differently depending if it is connected to a light or not:
e If it is connected to a light, the only possibility is to connect a light source shader.

e If it is not connected to a light, the interface shows three tabs that correspond to three
RenderMan(©) shader types: surface, displacement and volume!!.

' Those are actually interior shaders.
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After specifying the shader, its parameters will appear in the interface and can then be
modified or animated. The Reload button is handy during shader development: it re-reads
all shader parameters and rebuilds the interface appropriately. More at Section 5.6 [Using
RenderMan Shaders], page 21.

NOTE: When specifying a shader with a relative path, 3DELIGHT FOR XSI will look in
the 3Delight Option property that applies to the entire scene. It has the following XsI
path: ‘Passes._3Delight_Options’.
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5 Rendering Guidelines

5.1 A Few Words About Tessellation

There is many differences between the 3DELIGHT render engine and XSI's internal renderer
but one that is very striking for XSrI artists is the absence of almost all surface tessellation
controls. The following geometric approximation properties are not needed in 3DELIGHT
FOR XSI:

Geometric Approximation - Surface
All the refinement settings are ignored. 3DELIGHT will tessellate surfaces as
required by the shading rate, which is specified in Section 4.1.1 [Quality], page 8
and can be modified on a per-object basis as in Section 4.2.1 [Quality Object
Property], page 15.

Geometric Approximation - Polygon Mesh
The Render Level property is interpreted as follows: a value of ‘0’ will render
the polygon mesh as usual and any value greater than ‘0’ will render the polygon
mesh as a smooth subdivision surface. Users will notice that rendering perfectly
smooth subdivisions is almost a no-cost operation in 3DELIGHT FOR XSI.

Geometric Approzimation - Displacement
Displacements are rendered to sub pixel accuracy as dictated by the shading
rate. The Max Disp. property is considered by 3DELIGHT and is of prime
importance for the quality and speed of displacements: values that are too
large will slow down the renders and values that are too small may cause cracks
in the rendered image. 3DELIGHT will issue warnings if the displacement bounds
are too large or too small.

Geometric Approximation - Surface Trim
3DELIGHT uses an analytical algorithm for trim curves (not relying on surface
tessellation). This means that all the parameters in this section are not consid-
ered and trim curves are always smooth.

Geometric Approximation - Hair
If Curve Type is set to ‘Quadratic’ or ‘Cubic’, 3DELIGHT FOR XSI will render
them as smooth curves. The Render Level property is thus not useful.

5.2 RIB Export and Import

IMPORTANT: RIB export and import functionalities are only exposed in 3DELIGHT FOR
xs1| Studio.

3DELIGHT FOR XSI can export RIB files using the standard Render -> Export menu in XSI.
Depending on the settings in the Archives and RIB Ezxport property page (see Section 4.1.5
[Archives and RIB Export], page 11, 3DELIGHT FOR XSI will export a monolithic RIB or a
multi-archive RIB. A monolithic RIB contains the entire scene and a multi-archive RIB will

contain a series of delayed reads that will load smaller archives.
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5.3 Ray Tracing in 3Delight for XSI

By default, ray tracing is disabled in 3DELIGHT FOR XSI. It is so because memory man-
agement is more efficient without ray tracing and large scenes will render efficiently. Ray
tracing is needed for the following two features:

e Ray tracing shadows

e Reflections

To enable ray tracing, uncheck the Ray Tracing -> Disable toggle in the render properties.

Anti-Aliasing

When tracing rays for shadows, reflections and refractions, a REYES based renderer such
as 3DELIGHT behaves differently than a ray tracer: rays are shot per micro-polygon and not
per screen sample. This means that to increase the quality of ray traced effects one has to
decrease the shading rate. This is usually very costly since decreasing shading rate has an
effect on overall performance and not only ray tracing.

A better solution is to increase the Samples parameter in your illumination XSI shaders
(such as ‘Phong’). Even if the Gloss parameter is set to 0, increasing the number of Samples
will increase the quality of your renders’.

5.4 Efficient Rendering of Hair

3DELIGHT FOR XSI exposes a few features that are well-suited for rendering of large amount
of hair?. This includes an efficient archive-based RIB exporter, a scene caching mode, and
the efficiency of the core renderer.

5.4.1 Render Settings

A very important thing to consider when rendering hair in 3DELIGHT FOR XSI is that there is
a costly phase even before the rendering starts: it is the phase where XsI actually computes
the hair positions and give them back to 3DELIGHT FOR XSI. In the lighting stage, this
phase can be greatly optimized by using archive-base RIB export and scene caching:

1. In the Archives and RIB Export tab of the render properties (see Section 4.1.5 [Archives
and RIB Export|, page 11), enable the Archive-Rendering and Exporting property.

2. Enable the Freeze Archives property.

When these two features are set, 3DELIGHT FOR XSI will only ask Xs1 for the hair data
once, write the data into RIB archives, and re-use the archives on all subsequent renders.
Note that this work flow is very good for any complex scene that is not being modified
(which usually happens in the lighting stage).

5.4.2 Quality Settings

In the particular case of hair rendering, quality settings should be influenced by the following
observations:

1 Since 3DELIGHT uses ray differentials, it can properly guess what is the angle span of any traced ray,
even if Gloss is set to 0.

2 Or similarly complex scenes
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e Generally, hair have a smooth shading variation (low frequency in the shading space)
and sharp geometric variation (high frequency in the screen space). This means that
using shading rates that are too low (see Section 4.1.1 [Quality], page 8) is usually
wasteful and using oversampling that is too low will produce aliasing, especially in
animation.

A good setting could be 2.0 for the shading rate, 8x8 oversampling, 6x6 pixel size and
using a ‘sinc’, ‘mitchell’ or ‘catmull-rom’ filter.

e Hairs are usually thinner at their tip, so a common practice is to specify this in the
XsI hair properties. This is quite often a mistake: making hairs very thin at their
tip is a challenge to almost all sampling renderers (including ray-tracers) since there
is a greater probability that no enough samples will catch hair geometry, and this is
the only needed ingredient to produce bad aliasing. A wiser thing to do is to leave
the tip as wide as the root but decrease its transparency proportionally to the desired
thickness. So if the tip is two times thinner than the root, use a transparency of 50%.
This “technique” will give far smoother renderers.

5.5 Rendering XSI Curves

3DELIGHT FOR XSI can render XSI's curves and there is no limitation on curve’s shape or
degree. The default behaviour is to not render curves so that existing scenes render exactly
as in XSI's internal renderer. To enable curves’ rendering:
e Select the desired curve and create a 3DELIGHT object property (see Section 4.2 [The
3Delight Attributes], page 15).

e In the properties, enable the Render Curves toggle that is part of the Geometry tab.

e Select an appropriate width for the root and the tip of the curve.

Please note the following:

e Curves are rendered using a 3DELIGHT primitive that is meant to render thin curves®.
Rendering thick curves is better done through proper NURB surfaces. Quality guide-
lines explained in Section 5.4 [Efficient Rendering of Hair], page 20 also apply in this
case.

e Since XsI will not let you assign materials to curve geometry, the only option is to assign
RenderMan(c) shaders (see Section 4.3 [The RenderMan Shaders Properties|, page 17).
To get you started, an example shader is provided in Section 5.6.4 [Writing Shaders for
XSI Curves|, page 24.

5.6 Using RenderMan Shaders

NOTE: This section contains some more advanced RenderMan(c) concepts. Omne should
be familiar with the basics of shader writing before reading this section. Additionally,
RenderMan(c) shaders assignment is only available in 3DELIGHT FOR XSI| Studio.

As explained in Section 3.1 [Integration with XSIJ], page 5, 3DELIGHT FOR XSI automat-
ically translates Xs1 shaders to compiled RenderMan(c) shaders. This means that no shader

3 Rendered using the RiNuCurves primitive.
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programming is necessary to use 3DELIGHT FOR XSI. However, it is logical to provide XsI
users with the added flexibility of using RenderMan(c) shaders, if needed. The following
sections explain how to connect RenderMan(c) shaders and how to write shaders that are
tightly integrated into XsI.

5.6.1 Connecting RenderMan Shaders

IMPORTANT: RenderMan(c) shaders are not connected using XSI material manager but by
using a special object property. The reasons for this are explained below.

Connecting a RenderMan(c) shader is a three step process:

a. Select the object to which the shader will be applied. Note that it is impossible to con-
nect RenderMan(c) shaders to clusters since the RenderMan(c) standard has no support
for such elements.

b. Get a RenderMan(c) Shaders Property by going to Render -> Property -> 3Delight ->
Shaders.

c. Select the surface, displacement, volume or light shader tab and specify a shader path.

Please note the following important details:

e A shader property can be inserted anywhere in the scene hierarchy. For example, it is
possible to put a RenderMan(c) shader property in the Scene_Root and that property
will be applied to all objects in the scene. This is the main reason of using properties
to connect RenderMan(c©) shaders.

e [t is possible to connect a RenderMan(c) displacement shader, leaving the surface shader
empty, and this will effectively use an XsI material for the surface and a RenderMan(c)
shader for the displacement.

5.6.2 Accessing XSI Vertex Properties

All xs1 vertex properties (such as vertex colors and UV coordinates) are available to shader
writers. Accessing a vertex property is as simple as naming it in the parameters list of the
shader.

NOTE: If there is 3DELIGHT attributes attached to geometry, make sure that Ezport
Vertex Properties is ‘on’. This parameter is on by default, as explained in Section 4.2
[The 3Delight Attributes]|, page 15.

Listing 5.1 shows how to access the Vertex_Color vertex property.

surface test(
varying float Vertex_Color([4] = 0; )

/* Put the color in the surface color */
Ci = color( Vertex_Color[0], Vertex_Color[1], Vertex_Color[2] );

Listing 5.1: An example RenderMan(c) shader accessing XSI vertex color properties.

Two noteworthy details about Listing 5.1:
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a. We use an array of 4 scalars to pass colors since those can also contain the alpha. Also
note that if you export Tangents they will end up as color properties since those are
encoded as a 4-tuple.

b. The varying keyword is needed in front of the parameter since vertex colors vary across
the surface.

Listing 5.2 shows how to access a UVW XSI property named Texture_Projection.

surface test(
string texturename = "";
varying float Texture_Projection[3] = 0; )

{
/* Access a texture using the given uvs */
Ci = texture( texturename,
Texture_Projection[0], Texture_Projection[1] );
}

Listing 5.2: An example RenderMan(c) shader accessing XSI uv properties.

Note that we are using a float[3] instead of a point in Listing 5.2 to declare the
parameter. This is needed because a point would have been transformed by the transfor-
mation matrix applied to the underlying object?; passing an array of floats bypasses this
“problem”.

5.6.3 Accessing XSI Render Channels

All xsI render channels are easily accessed by naming them as output varying shader pa-
rameters. The names are the same as in the XsI interface: ‘Diffuse’ for the diffuse channel,
‘Specular’ for the specular channel, ‘Ambient’ for the ambient channel and so on. Listing 5.3
shows an example shader that sets some of XSI render channels.

4 As per the RenderMan(C) specifications.
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surface renderchannels(
output varying color Specular = O;
output varying color Diffuse = 0;
output varying float Depth = 0; )
/* This will set the Diffuse/Specular render channels in XSI */
Specular = noise( P );
Diffuse = diffuse( N );

/* Store the depth, in XSI infinity is set to 0. */
Depth = depth(P);
if ( Depth > 1e36 )

Depth = O;

/* Put some different color pattern in the color */
Ci = cellnoise( P *x 2 );
Ci *= 0i;

Listing 5.3: An example RenderMan(c) shader to access XSI render channels.

Accessing store-in render channels is similarly easy: the store-in has to be declared as
parameter of the shader, with the correct type.

5.6.4 Writing Shaders for XSI Curves

As explained in Chapter 3 [Features Summary|, page 5 and Section 4.2.4 [Geometry Object
Property]|, page 16, 3DELIGHT FOR XsI can render XSI curves of any shape and of any degree.
Since XsI does not allow connecting a material to such geometric primitives, the only option
for shading is to assign a RenderMan(c) shader. A few remarks:

e 3DELIGHT FOR XSI exports curves’ length with each curve using the xsi_curve_length
variable so shader writers can have access to it by declaring it as a parameter of the
shader.

e RenderMan(C) curves vary in ‘u’ across their width and in ‘v’ across their length.

e Curves knot vector is normalize between 0 and 1 so ‘v’ varies between 0 and 1.

Listing 5.4 gives a simple example of such a renderman shader. Note the presence of the
xsi_curve_length variable that is available to shader writers and automatically passed as a
primvar to all curve primitives.



Chapter 5: Rendering Guidelines 25

/*
A simple shader that demonstrates how to cut a curve at a specific
length. This example shows how to:
-- access curve’s length
-- set the opacity using an anti-aliased step function
*/
surface curve_cutoff (
float xsi_curve_length = 0; /* This is set by 3Delight for XSI x*/
float cutoff = 0; )

/* compute distance from root */
float current_length = v * xsi_curve_length;

float f = filterstep( current_length, cutoff );

/* Opacity becomes O after the cutoff */
0i = £f;

/* Set the color to white and modulate by opacity as usual in
RenderMan shaders */
Ci=1x* 0i;

Listing 5.4: A simple shader for XSI curves.

5.6.5 Accessing Reference Geometry

Reference geometry can be output as the usual Pref and Nref RenderMan(C) primvars by
enabling reference geometry output in Section 4.2.4 [Geometry Object Property], page 16.
Listing 5.5 illustrates how to access the reference geometry from inside a shader.

surface prefaccess(
varying point Pref = 0;
varying normal Nref = normal(0, 0, 1); )

Ci = diffuse( Nref ) * noise( Pref );

Listing 5.5: Accessing XSI reference geometry from inside RenderMan(c) shaders.

Note that exporting reference geometry will double the size of the object so this feature
should be enabled only when strictly necessary.

5.6.6 Writing “Cluster Aware” Shaders

It is possible to access clusters’ sort order property from inside a RenderMan(c) shader as
shown in Listing 5.6. This is an easy way for a TD to create clusters and write particular
code for each one of them.

NOTE: To export the cluster sort order, it is necessary to attach 3DELIGHT attributes
to geometry and switch the FExport Cluster Sort Order property to ‘on’. Refer to
Section 4.2 [The 3Delight Attributes|, page 15.
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surface test(
uniform float xsi_cluster_sort_order = 0; )

/* Just put the sort order as a gray scale value */
Ci = xsi_cluster_sort_order / 255;

Listing 5.6: An example RenderMan(c) shader accessing cluster’s sort order.
Note that a uniform variable is enough here since the sort order of each cluster doesn’t

vary across one single polygon.

5.7 Supported XSI Shaders
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